
Oh, How? Oh!
How to update your H2a data spreadsheet using the iCERT system



Don’t worry, you’ll Excel!

Set up your base Excel spreadsheet to match the columns you’ll find at 
icert.doleta.gov. 

This makes it much easier when you copy and paste the basic job order 
information from the list of new job orders on the website!



What else will you want to know?
Add other columns for the information you will want to gather from each application’s documentation. 

For example, we often include:

• Crop Activities

• Number of Workers Requested

• Referral and Employer Contact information 

• Work Site Street Address

• Work Site City, State, Zip

• Work Site County

• Notes about Work 

• Housing Site Address

• Housing City, State, Zip

• Housing Site County

• Housing Description & Notes



Freeze!

A handy tip is to freeze the top row 
of your Excel spreadsheet. This 
allows you to see the column labels 
no matter how far down you scroll 
and can be helpful when you’re 
entering data. 

You will find Freeze Panes under the 
View Tab in Excel. 



Freeze!

Select ‘Freeze the Top Row’

Note: If you don’t see the View tab, it’s 
likely that you are using Excel Starter. 
Not all features are supported in Excel 
Starter.



A Very Good 
Place to Start

Begin on the iCERT Home 
Page 
http://icert.doleta.gov. 

You do not have to log in. 

http://icert.doleta.gov/


Let it scroll!

Instead, scroll down until you find the Public Job 
Registry and ‘click’ the button.





The State You’re 
In

Select the state you want 
from the drop-down menu.



Closer to home?

There is also an option to search for job listings only within a specific 
distance (10, 20, or 30 miles from a specific zip code).



It’s a date…range!

When searching on icert it’s 
helpful to set a date range 
on the job orders you’re 
looking for. 

If you’re just updating a 
spreadsheet, that’s easy. 
Start with the date of the 
last job order posted that 
you updated! 



So, if you have updates through 12/4/18 then you’ll want to set the 
start of your date range as From: 12/4/18  To: today’s date. 

This will help make sure you’re not missing any that posted after you 
updated. If you have all of them from the 4th, it’s easy to switch your 
date range to 12/5/18 to today’s date.



Not a bot!

You will have to prove that 
you’re not a bot with a 
reCaptcha fill in the box 
before you’re allowed to hit 
enter on your search, but it 
only takes a few seconds. 



Is Advanced Search helpful?

Advanced 
Search give you 
the option to 
refine your 
search by Work 
Range if you 
want that as 
well.



Still not a bot!

It will make you do 
this repeatedly as 
you continue to work 
because your 
verification will 
expire or time out. 



Double Vision

It’s very helpful, no matter your monitor set up, to be able to see the 
Excel spreadsheet you’re working with and the icert.doleta.gov web 
page at the same time. 

You will save yourself a lot of clicking if you don’t have to minimize the 
web page or spreadsheet every single time! So, make sure you can see 
both by shrinking each one until they only take half of your screen if 
you have a single monitor. 

If you have a double monitor, it’s even easier! Simply keep one on each 
screen.





Sort it Out!
You can sort the job orders using the different headers, e.g., job posting 
date, work start date, work end date, etc. 



Copy that!

You can, of course, hand 
type all the listings in, 
but there’s an easier way 
to get all your initial 
listing information. 

Set the view to 30 
listings per page (not 
necessary, but it’s nice 
to get more at a time!) 



Gotta catch ‘em all!

Now, starting in the upper left-hand corner, highlight all the listings. 



Scroll down to the bottom, hold down ‘shift’, and click to the far-right bottom corner 
to make sure everything is highlighted. 

Now, copy it using your preferred method. Ex. Right click and select Copy on the pop-
up menu or hold CTRL  and C at the same time.



Paste!

Now, go to your spreadsheet and 
click in A2 or your next available 
empty cell if you’re updating a 
spreadsheet. 
Now Paste using your preferred 
method. 
Ex. Right click and select Paste from 
the pop-up menu or hold down CTRL 
and P at the same time. 
Depending on your internet speeds it 
might take a few moments to show 
up!





Matchy Matchy! 

Now, when you Paste the cells will contain hyper links and other 
formatting you may want to clean up. 

There are several ways/steps to do this. 

If you already have rows from previous updates formatted the way you 
like you can use the use the Format Painter on the Home tab to quickly 
apply the same formatting (font style, etc.) to the rows you just added. 

Click on the Format Painter icon:

• The pointer changes to a paintbrush icon. 

• Click and drag down the row numbers you just added to apply the 
formatting. This only works once. If you want to do more you’ll need to 
click the icon again or to change the format of multiple selections in 
your document, you must first double-click Format Painter.

• To stop formatting, press ESC.



Remove hyperlinks
As you work you may not want to run the risk of 
inadvertently clicking active hyperlinks in the ETA 
case number, etc. 

If you want to remove hyperlinks from one or 
more Excel cells, simply select the cells containing 
the hyperlinks and then either

• From the 'Editing' group on the Home tab of 
the Excel ribbon, select the option Clear → 
Remove Hyperlinks (see right).

• Note that this command will remove the 
hyperlinks in the selected cell(s), but the 
formatting of the cell(s) will remain unchanged.



Option B

Use the mouse to right-
click on the selected cell(s) 
then, from the right-click 
menu, select the option 
Remove Hyperlink (or 
Remove Hyperlinks if you 
have more than one cell 
selected).

This option removes the 
hyperlinks and the 
formatting from the 
selected cell(s).



How to delete all hyperlinks in 2 
clicks (only in Excel 2010 and 2013)

• In Excel 2010, Microsoft finally 
added the ability to remove 
multiple hyperlinks at a time:

• Select the entire column (or the 
whole sheet) with Hyperlinks: click 
on any cell with data and press 
Ctrl+Space.

• Right-click on any selected cell and 
select "Remove hyperlinks" from 
the context menu. 

• All hyperlinks are removed from the 
column.



You have a few ways of clearing text formatting. First, once 
you paste, a small pop-up will appear and give you three 
options:
• Keep Source Formatting will preserve the text as you 

copied it. (Shortcut: Press CTRL + K, to select this after 
pasting).

• Merge Formatting will force the text you’re pasting to 
match the text around it. (Shortcut: Press CTRL + M, to 
choose this after pasting).

• Keep Text Only will only take the text and give it no other 
formatting. (Shortcut: Press CTRL+ T, to do this quickly 
after pasting).

• When this bubble appears, you can even choose which 
option to set as default. If you’d like, you can also 
accomplish this using the Paste Special option under Paste
on the left side of the Home ribbon. It’s effectively the 
same option, though it gains more functionality if you’re 
pasting more than just text.



All cleaned up!



Icon removal

At times you may end up with PDF 
icons in two of your columns after 
cleaning up the rest of your 
formatting. 

You will simply need to hold down 
CNTRL as you click each one and 
then delete them. 

If you find a faster way let us 
know!



You will do this copy, paste, and clean-up process for each page of job 
orders on the web site. That’s why it’s nice to do 30 at a time instead of 

10!



All cleaned up and ready to go!

Okay, now we are ready to start adding in the 
additional information you need. Go to the top 
of the list and on the right-hand side you’ll see 
two columns the PDF icons. The first column 
labeled Job Order is Form ETA 790. 

The second, labeled Cert, is Form ETA-9142A. 

Form ETA 790 contains housing information 
and other details that ETA-9142A does not. As 
you can see, some job order applications will 
have both and some will only have one. 



Filling in the Blanks

Click the first ETA Form 790 
PDF icon. A new tab will open 
on your web browser. 

A filled-out version of this form 
will appear. Some are worn 
and faded, others are typed, 
and many are hand-written. 



Box 1

In box one you’ll find:

The Employer’s Name and Address

Phone Numbers

Email address



Box 2

Box two is where you’ll find the 
list of work site address and 
directions. If there are too many 
to fit in this section, they’ll be 
continued in Box 28 on page 7 or 
in an attachment. 



Box 3

Box three is where you’ll find 
the list of housing site 
addresses, descriptions, and 
directions.

If there are too many to fit in 
this section, they’ll be 
continued in Box 28 on page 7 
or in an attachment. 



Hard to Read?

If the addresses are incredibly hard to read make sure to scroll down 
and check the attachments. 

At times there is a clearer typed form included that has both housing 
and work site addresses. It’s worth looking for!



What if there’s more than one?

Many applications have information on multiple work sites and housing 
site addresses. 



There you go! Insert a row!

If there’s more than one 
worksite and/or more 
than one housing site 
address, you’ll want to 
insert another row for 
each one under your 
original listing for that job 
order. 



Paste & Go

Then, copy and paste the information you want to keep from the 
original row (like the ETA Number, Job Posting Date, Employer Name, 
Type of Worker, Crop Activities, etc.) and put in the additional housing 
site or work site information in the appropriate columns. 



Box 10

This is where you’ll find the 
numbers of workers the 
employer has requested.



Box 15
Scroll down to page three of the 
form and you’ll find Box 15. This 
is where you’ll often find referral 
information and a company 
contact. Sometimes they’ll just 
refer you to Box 1 and other 
times a specific contact person 
with phone number and available 
times will be listed. 

You might have to search within a 
lot of text in this box to find the 
information you need.



Page Four, Find out 
More!

In Box 17 is where you’ll find out the specific 
Crop Activities the employer wants workers to 
perform or the crop they’ll be working with. 

At times only one will be listed, other times the 
list continues below the available spaces. 



Box 16

If a description in Box 17 is too 
vague or doesn’t list a crop, go 
back to Box 16 and check the job 
description requirements. You 
might be able to find more 
information there. 



Box 28

Box 28 is for 
extras. Extra 
housing or 
work site 
information, 
etc., that 
couldn’t fit in 
Boxes 2 and 3. 
If it doesn’t all 
fit in here 
employers will 
also have 
attachments 
with their 
applications. 



County information?

Sometimes the application will include the work site or housing site 
address county information. If not, it’s easiest to just keep a tab in your 
browser where you can easily update a search phrase with each city 
you want to look up. 



Form ETA-9142a

If they don’t have Form ETA 790 then 
you can get a lot of the information 
you need from the document in the 
second column of PDF links. Form 
ETA-9142a. 

These are nearly always more legible 
than the other form, but don’t 
contain the same amount of 
information.



Section B, Box 7

In section B, Box 7 of 
Form ETA-9142a you 
can find the number 
of workers requested.



Section D

In Section D, on page 
2, you’ll find the 
employer’s point of 
contact information.



Section F

On page 3, section F, you’ll 
find the Job Description 
where you can determine 
what crop activities the 
workers will be doing. 



Section G

In section G, on page 4, you’ll find the 
main worksite information. Additional 
worksite addresses may be listed as 
well.

You will not find housing information 
in this form.



On we go!

Congratulations! You’ve now completed gathering information from 
one job order!  Close out that tab. 

Click the second ETA Form 790 PDF icon. A new tab will open on your 
web browser. (…)

It’s time to do it all again (and again) until you get to the end!

Need a refresher when you get to Page 2? Go back to slide 18!


